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O o p s !  a n d  L e g a l  S t u f f  
 

While I have made every effort to ensure the accuracy of this document, including 

grammar and instructions, I make mistakes. (Surprise!)  If you find an error or want to 

provide constructive feedback, please contact me.  Thank you!  Enjoy Your new Office 

and this document. 

 

Greg Creech 

Techedutainment Services, Inc. 

P. O. Box 1431 

Pine Lake, GA  30072 

www.gregcreech.com 

 

Association Memberships, Certifications, and Awards: 

 International Association of Administrative Professionals – Atlanta Chapter 

 American Society of Training and Development Member – Atlanta Chapter 

 Society for Human Resources Management – Atlanta Chapter 

 Microsoft Office User Specialist Certification – Instructor 

 A+ Certified through CompTIA 

 Microsoft Certified Technical Trainer 

 2007 Top Non-Credit Programs (my Microsoft® Office Suite) by University 

Continuing Education Associations’ Southern Region 

 2009 Faculty Award for the Association of Continuing Higher Education (for my 

work at Emory University) 

 

Word ® is a most excellent product from Microsoft ® Corporation and is part of the 

Office ® Suite (including Office 2007/2010 ® of products and services, including Excel, 

PowerPoint, Access, and other fantastic programs that help me to be productive and 

profitable. 

 

Copyright © 2010 Greg Creech, Techedutainment Services, Inc..  All rights reserved.  

This publication, or any part thereof, may not be reproduced or transmitted in any form or 

by any means, electronic or mechanical, including photocopying, recording, storage in an 

information retrieval system, or otherwise, without express written permission of Greg 

Creech, P. O. Box 1431, Pine Lake, GA  30072-1431, www.gregcreech.com. 

 

http://www.gregcreech.com/
http://www.gregcreech.com/
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A b o u t  G re g  C re e c h  a n d  I A A P  
On January 5, 1981, I entered the world of being an administrative professional as the only 
male Steno Clerk in Columbia, SC at Southern Bell. As my manager, Becky Davis, introduced me 
to all of the women, one funny woman exclaimed: “Well, there goes the steno pool; they let a 
rooster in the hen house!” Later in the day, I used an IBM Selectric typewriter to type a 
proposal. As it typed, I noticed the silence in the room and looked up to see everyone staring 
at me. The funny woman said: “I’ve never seen a man that could type like that. Who would’ve 
thought.” I could type 70 WPM with no mistakes. I worked in Sales and Marketing at AT&T in 
many clerical, administrative, and management positions. My longest responsibility for over 10 
years was as a Compensation Manager in Sales and Marketing for various sales organizations , 
and in 1998, I took an early retirement buy out package as an Operations Manager. AT&T 
supported my comedy, musical, and motivational presentations internally and externally, too, 
so I had the best of both worlds: administrative position and entertaining presenter. I continue 
to enjoy at&t as a customer and supplier. 
 
Since 1998, I have pursued my passion and love of technology, education, comedy/humor, 
music, and administration. In April, 2006 for Administrative Professional Day, I presented my 
musical, humorous stress management speech at Midlands Technical College with over 650 
admins in my home town of Columbia, SC. Four months later, I and Mary Stuckey, my neighbor, 
were at a neighborhood meeting and she informed me that she was being installed as President 
– Georgia Division of IAAP. Mary and I have been neighbors for 9 years at that point and we 
never knew of our administrative connections. I told her about my presentations and programs. 
In November, 2006 at an IAAP Educational Seminar in Macon, GA I presented my humorous, 
musical presentation on business communication, stress management, and career development 
entitled “SMILE”. I joined IAAP in 2007. The presentation was a hit and I have been blessed by 
frequently presenting at chapter meetings, conferences, and other events. Being at EFAM is an 
absolute dream come true for me and I owe much thanks to my sisters in Georgia chapters for 
all of the good recommendations, referrals, prayers, and compliments. I hope you enjoy my 
presentations as much as I enjoy presenting them. 

A b o u t  t h i s  S e s s i o n  a n d  m a n u a l  
This session and materials focus on the Microsoft

®
 Office Power User. My definition of a 2010 

Power User is someone who works in the major products (Word, Excel, Outlook, PowerPoint, 
and others) daily or quite frequently. I designed this session for Admins that currently use the 
products and want to go to the next level AND learn new features/functionality of the Office 
2010 Suite. I have written the manual for 2003 and 2007 users so no matter your previous 
version this session and manual will help. I will have a manual entitled “Lucky 13 – Reasons to 
enjoy Office 2013” in the autumn of 2013 that will be similar as this handout.  I am updating all 
of my manuals, materials, files, and videos to Office 2013/Office 365, so look for my updated 
materials over the next year (or so) for Access, Excel, PowerPoint, Word, OneNote, Outlook, 
Windows 8 and combinations of applications. I look forward to helping you in the conversion to 
Office 2013/Office 365 and Windows 8. Also, I am a Mac and Office 2011 instructor as well as 
iPad courses. You may view descriptions and purchase my materials through 
www.gregcreech.com. I have free handouts, like this one, and other materials available at my 
website, too. 
  

http://www.gregcreech.com/
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We l c o m e !  

M o v e  i n t o  y o u r  n e w  O f f i c e  
Not since we moved from command codes to icons in the early 1990’s have I been this 

excited about a version of Office and neither has there been a more magnificent change to 

the Office system. We have new, task-oriented interface and enhancements to all 

products within the suite.  You’ll find getting to “advanced” features easier, such as Mail 

Merge in Word, Custom Animation in PowerPoint, and PivotTables in Excel. Also, with 

the popularity of tables and data tracking the products, particularly Word and Excel’s 

tables, Microsoft has added more capabilities and formats for creating, editing, and using 

tables. 

Since you are a current Microsoft Office 2003/2007 user, you will, like me, need some 

time adjusting to where items were in previous versions of Office and where items are in 

the new version of Office, especially if you are moving directly from Office 2003 to 2010 

and bypassing Office 2007.  Don’t worry if you experience lapses in productivity in 

finding items and knowing if Microsoft has removed or simply moved the item to a new 

location that it the purpose of this book and course to help you know the differences and 

quickly get up to speed in using the new interface and popular features both from Office 

2003 and Office 2007 migration. 

As with any new version of software and products there are some negative issues to 

address.  One example for Office 2007/2010 is backward compatibility – to open a file 

saved as a 2007/2010 file in a previous version of Office requires a converter.  You can 

save the file as a previous version of Office, such as 97 – 2003; however, you lose the 

XML format, other formatting, and powerful features of 2007. 

Your new Office is ready, let’s move in. 

A b o u t  t h i s  C o u r s e .  .  .   
I designed this course and book only for current Microsoft Office 2003 and 2007 users 

regardless of the previous version whether Office.  This book is not designed for people 

who are completely new to Office – I have other books and courses for new users.  We 

will compare the differences in previous versions with the new version so you’ll know 
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where your important icons, menu items, and commands are located in the new Office. 

We’ll look at the similarities with the Office 2007/2010 and previous versions, too, such 

as the good, old Keyboard Shortcuts. While some organizations migrated to Office 2007, 

many have not migrated to 2007 and will lead directly into Office 2010. Those clients 

that did migrate did not fully utilize the new interface nor use many productive shortcuts 

that I have included in this book.   

We will examine Word, Excel, and Outlook and the common features in all of the Office 

Suite and then we will look at specific changes to Word, Excel, and Outlook. This book 

will not be exhaustive in your quest for knowledge and being a poweruser but does give 

you a quick start and reference for using the new interface, command buttons, and 

making you more productive quicker.  This book will help you determine where you may 

need to continue your education, such as in Excel.  However, this book may be all you 

need for your transition to the new Office. 

Enjoy your course and your new knowledge in Office 2010. 

Now, let’s get started winning in Office 2010. 

Write your notes here: ________________________________________ 

_____________________________________________________________ 

_____________________________________________________________. 
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S O S !  H e l p !  
Whatever happened to Links the Cat and Clippit?  Microsoft has laid off (or fired) your 

Office Assistant or as the Help system so kindly displays “Removed from product”!  For 

years, clients have loved or adamantly hated the Office Assistant – I used the Office 

Assistant when needed but some of my clients kept the Assistant open all of the time – no 

more.  In fact, Microsoft has removed some of the more “fun” and creative aspects of the 

applications, such as Text Effects in Word.  Also, gone with Office 2002/2003 is the 

Office Toolbar.  

With this version of Office you will definitely need to 

use and know the Help system. A very important item in 

your Help system is where items were in previous 

versions of Office and where items are now in the new version.  

I use this a lot in trying to search where items are located in the 

new version.  Pictured at right is how I discovered the untimely 

removal of the Office Assistant and WordPerfect Help is gone, 

too.   

Thankfully we may still press the 

F1 key on our keyboard to quickly 

access help and we my click the 

Help command button (Microsoft 

uses the words command button to 

replace the use of the word 

“icons”.)  The command button is 

at the upper right corner of the 

applications’ screen and displays 

here for you with the screen tip.  

This activates the menu at right..  I 

have entered “2003 Commands” 

in the box and searched on those 

words.  Please ensure that you are 

connected to the Office help system 

online.  The lower right message 
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box informs you of where you are retrieving your help.  The Interactive Guide only 

operates when you are online with 

Office help.  Microsoft Office has 

done a good job of introducing 

you to the interface and provides 

the correct names of items, such 

as Ribbons and Groups.  I 

navigated to the site through 

Getting Stared with Word 2010, 

but this is available to all 

applications and you choose your 

application from the menu 

pictured on the previous page. After searching for 2003 Commands and at the Getting 

Started pane, Click this hyperlink to activate the Start the guide screen – You may need 

the Adobe Flash Player. 

  A Hot Tip!  In the Start the guide window, there are other options 

for you to use rather than the Interactive 

Guides.  You may download a printable list of 

Command Buttons and the Ribbon in Excel.     

After clicking the Start the guide item, the Welcome screen 

appears for you to Start your 2003 to 2010 command 

reference guide.  Click Start and the interactive guide installs 

and is ready for you to choose a menu item and have the 

system alert you where the item has moved in 2010.  I 

have chosen Insert, Picture, from file and a screen tips 

alerts me as to where this item is in Office 2007/2010.  

Also, if I click the From File item, the guide demonstrates 

where the item is in Office 2007/2010 for me.  This is a 

really neat and easy to use method of knowing where your 

commands are located and if Microsoft has removed an 

item from the application.  Enjoy!  
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Ne w  F i l e  Fo r m a t s  

With the new Office comes new file formats for the applications. Since Office has 

converted to Extensible Markup Language (XML) as the file format and uses XML 

technology, the formats and extenstions needed changing too.  Using Extensible Markup 

Language reduces files size, risk of corruption, and prevents viruses from embedding in 

the code or macros.  Each application saves NEW files in the 2007/2010 format.  If you 

need to share your 2007/2010 files with users that do not have Office 2007/2010 there are 

a few options for you: 

 The user can use the Office converter to convert to the 2007/2010 File Type to 

view and edit the file in their version; BUT if they save the document in the 

earlier version the file looses the 2007/2010 formatting and features.  

 You can save two copies of the document using Office 2007/2010 and the Save 

As feature. One copy would be your 2007 version with all of the formatting and 

features of 2007 and the second copy would be another version, such as 97 – 

2003, with limited functionality and updated features. This may become 

cumbersome for you to maintain two copies and two versions of the file. I use my 

2007 version as the main version and as I make changes I use Save As to save the 

updated file using a different name to the 97 – 2003 format.  Overwriting and 

using the wrong file can occur and maintaining two copies may be confusing.   

 When you save a file in 97 – 2003 version, your file displays Compatibility Mode 

on your title bar. 

 There are conversion problems between Office 2010 and Office 2007, too.  Some 

of the fancy and wonderful text effects in Word 2010 don’t convert well to Word 

2007.   

 The Table below displays the type of files and the new formats/extensions for you 

to save your document, workbook, or presentation. 

 An Important Gotcha!  If you are working on a 97 – 2003 version of a file 

in Office 2007/2010, some of your command items and buttons will not be 

active (or “grayed out”).  You may not use all of 2007/2010 features and 
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formats if previous versions of a file. Your conversions to the new format 

won’t be without some headaches, too.  I have had to work in a dual format 

and it can be confusing and frustrating between different versions of the file.  

I look forward to the day when Office 2007/2010 is the standard.  

Office Files and Extensions/Formats 

Type of File New 
Extension/Format 

97-2003 Word Document .doc 

97-2003 Word Template .dot 

2007/2010 Word Document .docx 

2007/2010 Word Document with Macros/Code .docm 

2007/2010 Word Template .dotx 

2007/2010 Word Template with Macros/Code .dotm 

97-2003 Excel Workbook .xls 

97-2003 Excel Template .xlt 

2007/2010 Excel Workbook .xlsx 

2007/2010 Excel Workbook with Macros/Code .xlsm 

2007/2010 Excel Template .xltx 

2007/2010 Excel Template with Macros/Code .xltm 

97-2003 PowerPoint Presentation .ppt 

97-2003 PowerPoint Template .pot 

97-2003 PowerPoint Show .pps 
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2007/2010 PowerPoint Presentation .pptx 

2007/2010 PowerPoint Presentation with Macros/Code .pptm 

2007/2010 PowerPoint Template .potx 

2007/2010 PowerPoint Template with Macros/Code .potm 

2007/2010 PowerPoint Show .ppsx 

2007/2010 PowerPoint Show with Macros/Cod .ppsm 

There are many other formats available for each application, such as Web 

Page, Text, RTF (Rich Text Format), and so on.  
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T h e  Ne w  I n t e r f a c e  
One of the best new features of Office 2007/2010 is the new user interface including the 

Quick Access Toolbar, Tabs, and Ribbon.  Microsoft calls this type of interface a 

results-oriented interface and I must agree – you truly will get to your desired results, 

effects, and functionality with less time and minimized frustrations – for the most part.  

The number of dialogue boxes has decreased and Task Panes are still around to assist 

you.  The good old toolbars, such as Standard and Formatting, that us old-timers have 

used since the early 1990’s are gone, except for one – the new Quick Access toolbar.  

Without a doubt using the new Office Suite will increase your productivity and make 

getting to functions much easier and with fewer clicks and less frustration.  The Home 

Tab in Word 2010 displays here with the Quick Access Toolbar below the Ribbon and 

above the Ruler and the Home Tab’s Groups and Command Buttons 

displayed.  

Besides the increase functionality using the tabs and ribbon, there is new 

power in using the shortcut menus with “right clicking” or using the 

secondary mouse button.   When you “right click” or use your secondary 

mouse button you still receive the Shortcut menu including some of 

your favorite commands, such as copy and paste.  Also you receive a 

Mini Toolbar containing favorite commands to use such as font, bold, 

the format painter and other often used commands.  This is another time 

saving feature for applying formatting to selected areas of your 

document, spreadsheet, presentation and other Office files. 

There is the new scrolling Zoom, replacing the Zoom box, in the status 

bar of all applications that changes your view as you scroll through your percentages.  A 

Command Buttons 

Groups 

Tabs 
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picture of the new scrolling zoom is at right and allows you to 

see your changes in “real time” rather than guessing the 

percentage you need.   

Office 2007/2010 offers a preview of your formatting, too, such as when you select your 

text and scroll through the fonts or font size the application will show you the effect 

changes before you make your final click or selection.  This feature is called Live 

Preview and saves a lot of time. 

We will examine these new user interface features and new ways to getting to old 

functionality, such as how the tabs and ribbons work in using popular formatting options 

for your documents, spreadsheets, and emails.  We will look at common features across 

the new Office 2007/2010, such as the return of File in Office 2010, Customizing the 

Ribbon, and the Quick Access toolbar. Then we will examine some of the new 

functionality in Word, Excel, and Outlook using the new interface.   

Welcome to your new office, now let’s get familiar with our new surroundings, and 

interface. 
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Q u i c k !  A c c e s s  t h e  T o o l b a r  

T h e  Q u i c k  A c c e s s  T o o l b a r  i n  W o r d  

For years and years we have used many toolbars in the Office Suite, gone are all of the 

toolbars, they are replaced with the tabs and pop-up dialogues boxes and task panes.  We 

still have one toolbar available for us to put our favorite commands.  The Quick Access 

Toolbar appears at the top your screen and pictured here. 

This has the Save, the (Very Popular) Undo, and Repeat command 

buttons on it.  You can customize the Quick Access Toolbar easily.  We’ll add some of 

my often used icons and actions to the toolbar – I encourage you to play around and add 

your own favorite icons.  

Here’s how to customize the Quick Access Toolbar using Customize 

Quick Access Toolbar: 

1. Click on the Drop Down arrow at the end of the 

toolbar and in the cascading menu choose some of 

your often used items, such as Quick Print and Print 

Preview. Clicking these items adds them to your 

Quick Access Toolbar.   

2. Unfortunately, you must keep opening the menu to 

add the buttons; the cascading menu doesn’t remain 

open as you click all of your buttons.  I have added 

all of my buttons to the Quick Access toolbar. 

 

Now, we will use the More Commands item in the Quick Access 

Toolbar. You want to use the More Commands and Customize panes for two reasons: 

 You can add more than one button at a time and you may add buttons not in 

the ribbon, 

 You can re-order the buttons to suit your needs. 
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1. To add other favorite command buttons click the More 

Commands … item on the Customize Quick Access Toolbar menu. 

2. The Word Options 

Quick Access Toolbar 

Customize screen 

appears pictured at 

right.   

3. First, I reorder my 

commands buttons to 

match how I had them 

for over 19 years using 

the Standard toolbar, 

so I move New to first 

place, Save and Save 

As are next, followed 

by Open, and then 

Undo, my favorite 

button.  You will want to move your buttons to suit your needs 

and productivity in locating a popular command quickly and 

easily no matter what tab you may use in the Ribbon. 

4. If you want to move the button, select it and click the up or down 

arrows at the right of the buttons for your toolbar.  This will 

move your selected command up or down on your toolbar.  

5. Next  Select Copy from the Popular Commands pane and add it to 

your Quick Access Toolbar – Notice that wherever your cursor or 

selector was located in the Customize Quick Access Toolbar pane 

Office adds the button beneath your cursor/selection.   

6. You may add your favorite buttons by double clicking the item, 

such as Font or Font Color, or selecting an item and clicking the 

Add button.  Your buttons add below where your 

cursor/selection is in the Customize Quick Access Toolbar pane. 

7. Notice at the top of the screen that we are making these changes 

to all of our documents (For all documents (default)).  You can 
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create and modify your Quick Access Toolbar for different 

documents and needs. 

Now, let’s use All Commands and add some of my favorite buttons. 

1. Change Choose command from box using 

the drop down list to All Commands. 

2. Wow! There are a lot of commands in the 

Office Suite.  We won’t add all of these. 

3. With an item selected in your All 

Commands pane, press the letter R on 

your keyboard – the Pane jumps 

to the letter R in the command 

list.  Next you may use the 

scrolling bar or keyboard arrows 

to move through your commands. 

We want to add Reveal 

Formatting to our Quick Access 

Toolbar.  Reveal Formatting isn’t 

in the Ribbon and is a cool button 

to use in order to know all about 

your formatting and to compare different areas of the 

document’s formatting differences.  

4. I add my favorite things in Word using the All Commands pane, 

such as: 

 Grow Font by 1 Pt, 

 Shrink Font by 1 Pt, 

 Change Case,  

 Change Shape,  

 100% Zoom,  

 Open Recent File… 

5. Continue to add some of your favorite commands to the toolbar. 

6. Don’t forget to reorder them using the arrow buttons. 

7. Once complete, click the OK button at the bottom of your screen. 
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Also, I like having my Quick Access Toolbar below the ribbon.  

You may place the Quick Access Toolbar below or above the 

Ribbon using the shortcut menu for the Customize Quick 

Access Toolbar that we have used previously. At the bottom of 

the pane, you may choose to Show Above/Below the Ribbon.  I 

am changing mine to Show Below the Ribbon as displayed 

here.  

 

  A Hot Tip! Adding buttons from a terrific shortcut menu! We 
can add any button on the Ribbon to our Quick Access Toolbar 
by right-clicking the button; in this case, I have my Show All 
button selected and right click on it to receive the shortcut 
menu that displays Add to Quick Access Toolbar.  Note – If the 
Add to Quick Access Toolbar is grayed out – then you already added the 
button! Let’s try it out.  

1. With the Home Tab’s buttons visible 

Right-click on one of your favorite icons 

– I’ll right click the Show/Hide button.  

2. From the menu choose Add to Quick 

Access Toolbar. 

3. The icon displays on your toolbar at the 

end.  

4. You can add and remove buttons with 

ease to and from your Quick Access Toolbar, using the shortcut 

menu.  But you cannot rearrange them unless you use the 

Customize Quick Access Toolbar pane in the Options menu. 

5. The shortcut menu on the Ribbon and Quick Access Buttons 

provide other options, too, such as Customizing and Minimizing 

the Ribbon that we will learn next. 

As you use your new Office, you’ll discover buttons that you will want available all of 

the time.  Unlike the previous versions of Office your Home, Insert, Page Layout and 

other tabs change your command buttons; therefore, to have a popular command 

constantly available without clicking a tab or right clicking, you’ll have to add it to your 

Quick Access Toolbar.   You may assign your command to a keyboard shortcut or use 

one already defined for you such as the ever popular CTRL + C for copy.   
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If you mess up your toolbar and 

want to put it back to the way the 

toolbar came from the Microsoft 

Factory or its original sate, in the 

Customization screen you can 

click the Reset button and Office provides this message.  If you click the Yes button, all 

of your customization disappears for you to start fresh adding your icons.  

Now, let’s accomplish the following: 

 In Excel, add some of your favorite buttons to your Quick Access 

Toolbar and rearrange the buttons for your needs. 

 In Outlook, add some of your favorite buttons to your Quick 

Access Toolbar and rearrange the buttons. 
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T h e  Q u i c k  A c c e s s  T o o l b a r  i n  
E x c e l  

1. With Excel open at a blank workbook, Click the Quick 

Access Toolbar’s Option arrow and add the buttons from 

the shortcut menu as displayed here.  

2. After adding the buttons from the shortcut menu, Click 

the arrow again and at the Customize Quick Access 

Toolbar click the More Commands… option. 

 

As we accomplished in Word, add your favorite Excel buttons 

using the Popular Commands item in the Choose commands 

from: box.  Here are some of my 

favorite commands to add to and 

rearrange on my Quick Access Toolbar 

using the Popular commands item: 

 Custom Sort 

 Insert Sheet Rows 

 Insert Sheet Columns 

 Set Print Area 

 Freeze Panes 

 Page Setup 

 Paste Special 

 Add your popular commands 

and rearrange them on the 

Quick Access toolbar by 

selecting a command and 

using the Up and Down arrows 

to move your buttons. 

3. Next change your Choose 

commands from box to All 

Commands as circled above.  

Press the letter A and scroll to AutoFilter.  Add AutoFilter to your 

Quick Access Toolbar this command button doesn’t appear on the 
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Ribbon and is very helpful.  This one button accomplished two 

tasks – first it will filter for whatever you have selected and it 

will turn on your filtering for you.  I also add the Clear Filter 

button.  Notice ALL of the Commands in Excel and add your 

buttons as you wish. Click OK. 

4. Next, decide if you want to show the Quick Access Toolbar above 

or below the Ribbon. 

Now, you are ready to work with productivity in Excel 2010. Let’s 

customize our Outlook’s Quick Access Toolbar, now. 

 

T h e  Q u i c k  A c c e s s  T o o l b a r  i n  O u t l o o k  

1. With Outlook open, Click the Quick Access Toolbar’s 

Option arrow and add the buttons from the shortcut menu 

as displayed here.  

2. After adding the buttons from the shortcut menu, Click the 

arrow again and at the Customize Quick Access Toolbar 

click the More Commands… option. 

 

As we accomplished in Word and Excel, add your favorite 

Outlook buttons using the Popular Commands item in the 

Choose commands from: box and then use the All Commands item in 

the Choose commands from 

box.  Here are some of my 

favorite commands to add to 

and rearrange on my Outlook 

Quick Access Toolbar: 

 Outlook Today 

 Categories 

 My Computer 

 My Documents 

 Copy 

 Paste 

Click Ok.  
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Now, that we have customized our Quick Access Toolbar it is time for 

us to customize our Ribbon with our own Tab – A Terrific New Feature 

in Office 2010. 

C u s t o m i z i n g  t h e  R i b b o n  –  Y o u r  
O w n  T a b  a n d  G r o u p s  

One of the disadvantages of Office 2007was the inability to customize the ribbon and add 

your favorite and popular command buttons to your own tab as you could create toolbars 

and add your icons in Office 2003 and its predecessors.  With Office 2010 you can create 

your own tab and groups then add your favorite command buttons.  We’ll build our own 

tab with often used command buttons, now. We’ll start in Word and then accomplish tabs 

in Excel and Outlook. 

1. In Word 2010, Right Click on a tab or 

anywhere in your ribbon and from 

the short cut menu chose Customize 

the Ribbon (You may click the File 

Tab and go to 

Options for 

Customize the 

Ribbon, too).   

2. Notice at the Top 

Right Pane you 

may choose 

difference Tabs to 

view, such as Main 

Tabs, All Tabs, 

Tool Tabs – we’ll 

work with the 

Main Tabs.  The 

main tabs are 

checked and listed 

below the 
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Customize the Ribbon box – I have checked Developer in order to 

perform Macros and Create Word Forms.  

3. Click the New Tab button, Word creates a New Tab and New 

Group for you. 

4. Next, select your New Tab and click 

the Rename button at the bottom of 

the pane.  The Rename  box appears 

for you to enter the name of your 

Tab – I am naming my tab “Greg’s 

Tab”.    After changing the name, click 

OK. 

 

 

5. Next select your New/Custom Group 

and click the Rename button at the 

bottom of the pane.  The Rename pane 

displays change the Display name to 

Format as displayed at right.  Click OK 

after changing your name. 

6. You can rename and change the 

picture/icon of many of your command 

buttons, too. 

 

 

Next we add buttons from 

the Popular Commands pane 

to our tab. As displayed at 

right, I am clicking and 

dragging my Format Painter 

from the Popular Commands 

pane and placing it under my 

Format (Custom) Group. 
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You may add buttons several ways: 

1.  With the command button you wish highlighted or selected click the Add 

button and the selected button adds underneath your selection in the right 

pane, 

2. Click and drag the command button from the left part of your pane to the 

right part of your pane and the Group.  

 Hot Tip! Shortcut menu and moving the Tabs.  You 

may right click on a Tab or Command Button in the 

Customize Ribbon Pane and from the shortcut menu 

perform many of the same options to avoid clicking 

buttons at the bottom or right of the pane.  Also, you may 

rearrang your Tabs by selecing the Tab and clicking and 

dragging the tab to its new location, you may use your 

shortcut menu as display at right or using the arrow 

buttons to move the selected Tab, Group or button up 

and down.  I have put my Tab (Greg’s Tab) first so that when 

I open an application this is the first tab that is available for 

me – you may want to keep your Home tab as the opening 

Tab.   

If you right click on a Tab you may show or hide that Tab 

using the Show Tab item and checking/unchecking it. You 

may remove a tab from this shortcut men, too.  

 An Important Gotcha! You can’t modify the buttons on the 

Quick Access Toolbar as you can using the Ribbon and your Tabs 

for your Command Buttons.    
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A d d i n g  m o r e  b u t t o n s  i n  W o r d .   

My custom tab, Greg’s Tab, appears below with my Groups and Command buttons.  This 

is a good example of how you will want to create your own tab and add your favorite 

buttons.  With the Quick Access Toolbar and Your Own tab in the Ribbon using the 

Office Suite has never been easier and more productive.  

1. Activate your Customize 

Ribbon pane in your Word 

Options by right clicking 

on a Tab on the Ribbon 

and Clicking Customize 

the Ribbon from the 

shortcut menu.   

2. Change your Choose 

commands rom box to All 

Commands.  Word 

alphabetically shows ALL 

of the available 

commands.  I am adding 

the Reveal Formatting 

button to my Format Group on my Tab by clicking and dragging 

the button from the left part of my screen to the right part of the 

pane illustrating my Tab and Groups. 

3. Similar to the Quick Access Toolbar I add my AutoCorrect 

Options, Grow Font by 1 pt and Shrink Font by 1 pt as well as 

other favorite formatting and page setup commands.  You should 

add the buttons and groups as you use Word and have your 

favorite commands in one place. 

 

 

 



IAAP and Greg Creech Office 2010 for Power Users  Page 26 

 

 

www.iaap-hq.org EFAM 2013 gregcreech.com 
Greg Creech © 2013  No Distribution or Duplication  

  Exclusive for IAAP and Techedutainment Services. 

 

 

 Modifying Buttons. We changed the Name of a Group and Tab, but 

you may also change the picture of a button. You may change the 

Name of your button and the picture the command 

represents. When I added the Print Preview 

Button and the Print and Print Preview Button 

(two different commands but the same picture), I 

couldn’t determine a difference without the Screen 

Tip. So, using my Customize Ribbon Pane I 

selected the Print and Print Preview button and 

clicked the Rename button (circled at right).  Using 

the Rename pane displayed here I chose the 

Smiley Face for my picture or symbol and I 

changed the Display name: to All in One Printing. Clicking OK changed 

my command buttons Name and Symbol in my pane and on my Tab.  

Select some of your buttons and change their name and symbol by using the Customize 

the Ribbon Pane. 

C u s t o m  T a b  a n d  G r o u p s  i n  E x c e l   

The process of creating and customizing your tab and groups in Excel is the same as in 

Word.  We will create a tab and a group and add some of our favorite Excel buttons to it.  

1. Activate your Customize Ribbon pane in your Excel Options by 

right clicking on a Tab on the Ribbon and Clicking Customize the 

Ribbon from the shortcut menu as displayed here with my 

Custom Tab named Greg’s Tab. 
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2. Create a New Tab by Clicking the New Tab button at the bottom 

of the Customize the 

Ribbon pane and then 

rename the tab – I am 

naming my tab - Greg’s 

Tab.  

3. Next create a New Group 

and rename the group.  I 

am creating another 

group displayed here 

named Format. I created 

a Data Group earlier. 

4. Create and rename other 

groups if you wish. 

5. Change your Choose 

commands rom box to All 

Commands.  Excel alphabetically shows ALL of the available 

commands.  I am adding the Conditional Formatting button to 

my Format Group on my Tab by clicking and dragging the button 

from the left part of my screen to 

the right part of the pane 

illustrating my Tab and Groups. 

6. Similar to the Quick Access 

Toolbar I add my AutoFilter, Clear 

Filter, Sort, Custom Sort, and 

other important and often used 

Excel Commands. You should add 

the buttons and groups as you 

use Excel and have your favorite commands in one place. 

7. After customizing your tab, groups, and command buttons, Click 

OK. You have your own, productive Tab in Excel. 
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O u t l o o k ’ s  C u s t o m  T a b   

The process of creating and customizing your tab and groups in Outlook is the same as in 

Word and Excel only the type of commands that we want differ.  We will create a tab and 

a group and add some of our favorite Outlook buttons to it.  

1. Activate your Customize Ribbon pane in your Outlook Options by 

right clicking on a Tab on the Ribbon and Clicking Customize the 

Ribbon from the shortcut menu as displayed here with my 

Custom Tab named Greg’s Outlook. 

2. Create a New Tab by Clicking the New Tab button at the bottom 

of the Customize the Ribbon pane and then rename the tab – I 

am naming my tab - Greg’s Outlook.  

3. Next create a New Group 

and rename the group.  I 

have created a Favorites, 

Let’s Go, and View Items 

groups.  

4. Create and rename other 

groups if you wish. 

5. Change your Choose 

commands rom box to All 

Commands.  Outlook 

alphabetically shows ALL of 

the available commands.  I 

am adding the Categories 

button to my Favorites Group on my Tab by clicking and dragging 
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the button from the left part of my screen to the right part of the 

pane illustrating my Tab and Groups. I am placing the button 

under Exit and above Copy. 

6. Similar to the Quick Access Toolbar 

I add my Outlook Today, Copy, 

Paste, My Documents, My 

Computer, and other important and 

often used Outlook Commands. You 

should add the buttons and groups 

as you use Outlook and have your 

favorite commands in one place. 

7. Also, I like changing my buttons 

especially for My Computer and My 

Documents.  After adding the 

button, I select the button and then 

click the Rename button.  While I can change the name of the 

button through the Display name box, I can change the picture 

or icon for the command, too. I am using the first button (the 

robot) for and I’m changing the button name to Greg’s 

Computer. Click OK. 

8. After customizing your tab, groups, and command buttons, Click 

OK. You have your own, productive Tab in Outlook to use in all of 

the objects and items in Outlook. 

 An Important Gotcha! In Outlook, your custom tab will not display in 

some of the items, such as New Message, New Appointment, etc. and your 

Quick Access Toolbar changes, too.  
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T h e  Re t u r n  o f  F i l e !   
There were many improvements in Microsoft’s Office with the release of Office 2007; 

however, using the Microsoft Office Button, pictured at right, instead of good, ol’ File 

was not one of the improvements and therefore disappears (YEAH!) with Office 2010. A 

File Tab returns bigger and better than ever. 

 

1. With a Word 

Document 

open, Click 

the File tab 

and click the 

Info item. 

2. My 

Information 

pane appears 

here with the 

ability to set 

permissions, 

share, and to 

use 

important document properties.  Notice that the left part of the 

pane contains our favorite commands of Save, Save As, Open, 

Close, and the Recently opened documents appear.   

 

Here are some of the items we will learn in using the expanded, more powerful, and 

simpler File tab. 

 Common Commands and Simple Recent list, 

 Recent – Pinning and unpinning, 

 Print – One Stop Shopping, 

 Save & Send – Saving in popular (PDF) and email at one place, 

 Options – Setting Important Options throughout the Suite. 

  



IAAP and Greg Creech Office 2010 for Power Users  Page 31 

 

 

www.iaap-hq.org EFAM 2013 gregcreech.com 
Greg Creech © 2013  No Distribution or Duplication  

  Exclusive for IAAP and Techedutainment Services. 

 

C o m m o n  C o m m a n d s  a n d  R e c e n t  
L i s t  

When you click the File Tab, Word should open at the Info Pane. The Info, Recent, 

New, Print, and other 

items all contain the 

Save, Save As, Open, 

and Close items as 

well as Your Recent 

documents list 

section. My Info 

Pane and File tab 

appear here. This 

pane is organized in 

three sections: Your 

Common Tasks and 

Commands in the 

right section, 

Important features 

and commands in the 

center, and then 

Properties to the left.  The Common Tasks and Features are consistent in the Suite, 

except for Outlook which we will look at Outlook’s File Tab later.  You may set the 

number of documents in the Recent Pane at 

the bottom.   

1. Click the Recent item on your 

File Tab and at the bottom of 

the pane change the number 

of items (I am changing mine 

to 10) in the Quickly access 

this number of Recent 

Documents. The limit is 50.  I use my Recent pane and pinned 

documents (we will learn this next) for items where I need a 

listing of more than 10. 
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2. Notice and use your Save, Save As, Open, and Close as you use 

the products and chance the number of Recent Documents. 

O u t l o o k ’ s  F i l e  T a b  

With some many different types of objects and items in Outlook, the File Tab in Outlook 

is different and will change 

based on the type of object 

and item in which you are 

working in Outlook. My 

Info Pane appears here; this 

pane contains the Add 

Account and Account 

Information item for you to 

view your Account Settings 

and edit/change them from 

the subsequent menus. 

Outlook’s File Tab doesn’t 

contain the Recent pane nor 

the Save, Save As, and other commands found in Word, Excel, PowerPoint, Publisher, 

and Access. 
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R e c e n t  ( a n d  I m p o r t a n t )  P a n e  
The Recent Pane 

displays your 

pinned and 

unpinned 

documents as well 

as the Recent 

Places area.  This 

saves much time in 

locating files and 

working with 

documents 

consistently and 

regularly.  By 

Default your list 

sorts alphabetically 

and the pinned documents area grows with the number of documents you want pinned.  

You can change the default of 17 recent documents up to 50 in your Advanced Word 

Option settings, which we will accomplish in a future section. Also, you may change 

your Recent documents number that appears in your common tasks (left area) of your 

screen below the Close command – not documents that appear in the Recent 

Documents/Workbooks panes as displayed above and below.   
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 A Hot Tip! Pinning document, workbooks, presentations, etc.  Across 

the Office Suite, except Outlook, helps you quickly open your favorite 

and often-used files. You pin your favorite files by clicking the push pin 

button at the right of the document or the recent place.  This pins the 

file at the top of the pane. You may unpin and remove from the list by 

right clicking on the file and the shortcut menu as displayed below 

appears for you to perform popular options, including Opening, 

Pinning/Unpinning, and Removing from List.  You should pinyou’re 

your Recent Files and Recent Places as you begin opening and using 

your files in Office 2010.  
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P r i n t !  O n e  S t o p  S h o p p i n g   

( A t  L a s t )  
Finally, one pane that contains your favorite Print AND Page set-up AND Print Preview 

in one place. We have had to bounce between Page Set-up, Print Preview, and Print for 

years to set our settings and customize our print jobs for our Office files.  Now, Your File 

Tab’s Print pane allows you to select your printer, collate, change the orientation, 

margins, and use Print Preview with a Zoom slider and easy navigation through your 

document, worksheet, and so on.  You may access this pane through the popular 

keyboard shortcut of CTRL + P. In using Office 2010, I have found this new Printing 

Pane very helpful and more productive than before.  

Also, Print Preview is still around and you may use the “traditional” Print Preview but 

this offers much of the same functionality; however, like Page Set-up you may need to 

use Print Preview for other items not featured in this Print pane.  
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In Excel, you may set your scaling, margins, 

worksheet printing in one convenient location 

now using the File Tab. My Excel Printing and 

some of my important Page Setup Options appear 

at right. 

 

 
 

  



IAAP and Greg Creech Office 2010 for Power Users  Page 37 

 

 

www.iaap-hq.org EFAM 2013 gregcreech.com 
Greg Creech © 2013  No Distribution or Duplication  

  Exclusive for IAAP and Techedutainment Services. 

 

S a v e  &  S e n d  
With a Word document or Excel workbook open, click the File Tab and trace to the Save 

& Send item and the menu below displays (I’m using Word, but the options are similar 

across the 

Office 

Suite.). This 

is a very 

helpful tab to 

quickly Save 

the Office 

document in 

a PDF 

format and 

email at one 

step You can 

publish your 

Office file to 

the web, 

SharePoint, 

blogs and 

other 

services.   
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N e w  ( A n d  I m p r o v e d )  
With a blank Word document or blank Excel workbook open, click the File Tab and 

trace to the 

New item and 

the menu 

below displays 

(I’m using 

Word, but the 

Blank options, 

location of 

templates and 

creating 

templates/file 

are similar 

across the 

Office Suite.).  

You may save 

all of your 

documents, 

workbooks, 

and other 

Office files as 

templates to 

use repeatedly 

to create 

separate files 

and not affect 

the templates’ 

contents.  The 

file extension for a template in Word is .dotx and Excel Templates are .xltx.   
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H e l p   
The Help item in the File tab provide means to get updates, diagnose your application, 

contact 

Microsoft, 

and to 

register and 

activate your 

products.  

This is a 

quick and 

easy to use 

resource and 

it is centrally 

located here 

for you.  In 

Office 2007, 

this was the 

Resources tab using the Microsoft Office button’s menu.  We will work with Options 

next that appears in this screen and is located on our File tab menu as Options.   
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O p t i o n s  f o r  y o u r  N e w  O f f i c e  
The File Tab contains the important Options that you should set for each of your 

Applications as you begin using Office 2010 and make changes as you need  later. 

The Options item is located at the bottom of your File Tab’s menu below Help and 

above Exit as displayed here. This is consistent throughout the Microsoft’s Office 

Suite of applications.   

P o p u l a r  O p t i o n s  

1. With Word Open and at a blank 

document, Click the File Tab, 

2. Next, click the Word Options 

button. 

3. The Word Options screen appears 

at the Popular selection. 

I have included the Excel Popular 

screen displayed below, too. 

4. You should set your Name, 

Initials, and Screen Tips options 

if needed, here.   

5. You may disable or enable the 

Mini Toolbar on selection; you 

may always retrieve the Mini 

Toolbar by right-clicking in the 

workspace of an application. I 

don’t know why in the world you 

would ever want to disable live 

Preview which shows you your 

formatting changes without 

actually making the changes 

until you click an item.   

6. In Excel you have the ability to set the number of worksheets in 

a new workbook and to change your font size and other options 

for you to set according to your needs and use of the application. 

I have set my font, Font size (which being over 50 years of age 
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goes up every year, now!), Default view, and I include at least 5 

worksheets in a new workbook.  We will examine the Mini 

Toolbar on selection and Enable Live Preview.  Please keep these 

options checked until you decide whether you like them or they 

annoy you in using the applications. 

Now, we will look at the other screens in your Options, so if you are in 

Word – Click the Proofing button.   

 

T h e  P r o o f  i s  i n  t h e  P r o o f i n g  T a b  

Another important tab for you to review is the 

Proofing tab.  This contains important self-

correcting features of the applications.  This contains 

the AutoCorrect Options. . . button in the new 

Office. 

Word has more options in the Proofing screen than 

Excel or PowerPoint and in Word you should check 

the Show readability statistics.  The Show 

Readability statistics displays a dialogue box to 

containing important information about your 

document such as what grade level you are 

composing, the number of passive sentences and 

other neat information about your document.  The 

dialogue box will appear after you check your 

Spelling and Grammar by using the F7 key or the 

command button in the Review Tab.  You should set 

how you want Word to check your spelling and/or your Grammar and Styles.  The 

Settings button and associated menu pane allows you to set what and how you want 

Word to check your spelling and grammar, such as using Contractions, Passive 

Sentences, Wordiness and so on.   
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S a v e  O p t i o n s  -  S a v e  E a r l y  a n d  S a v e  
O f t e n   

The Save options are consistent 

across the applications and allow 

you to change the type of file you 

are storing and where your default 

locations of your files are.  The 

Word 2010 Save Options screen 

appears at right; the Save Options 

screens are very similar across the 

applications. 
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T h e  E a s y  t o  U s e  A d v a n c e d  O p t i o n s  

The Advanced Options screens are essential to review in each of the applications and 

contain time saving customizations for 

you and how you like to use the 

applications.  Please don’t think of 

Advanced as difficult; I think this should 

be renamed to Important Options.  

There are options for Cut, Copy, and 

Paste, Printing, and many more.  Here 

are some of the options I like to change 

or to check in using Word: 

 Inserting Pictures as a Tight 

Format and decide my defaults 

for copy and paste, 

 Changing my Recently Used  

Document list to 50 in the 

Display section, 

 Entering my Mailing Address at 

the end of the pane for Word to 

use as my return address for 

envelopes, labels, letters, etc. 

After setting your Important Options 

click OK.  

Excel, Outlook, and PowerPoint have no 

shortage of Options in the Advanced 

areas and you should review those 

applications for how you want your 

Office application to work for you.   
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O t h e r  O p t i o n s  

There are other Options, such as Add 

Ins, Display, Formulas, for each of the 

applications.  You should review those 

as well.  My goal is to provide an 

overview and let you know of important 

options that you should set as you first 

start using Office 2010 and to be aware 

of where your items have moved from 

the good, old Tools and Options in 

previous versions of Office.  We have 

used the Customize Ribbon button and 

menus as well as our Quick Access 

Toolbar panes.  The Add Ins install 

programs and services you can use with your applications if you need additional 

functionality, such as Excel’s AnalysisPak. The Trust Center will allow you to review 

your security, permissions, and other settings – please use these items as you need for 

your application and organization. Language has its own space, now, and menu for you 

to choose your language(s) and settings.   
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O u t l o o k  O p t i o n s  

G e n e r a l  P a n e   
Outlook Options have been disorganized since Outlook Version 1.0 and the previous 

menus and organization were cumbersome. Outlook 2010 improves the organization and 

the interface for accessing many important and fundamental options that affect Outlook 

overall.  In my LookOut! Outlook 2010 course I cover all of  these options, so this 

section can only permit some of the important options that you will want to know and 

review.   

With Outlook 2010 open, click the File Tab and then click the Options 

item at the bottom of the left pane above Exit.   

Your Outlook Options pane opens at the General pane. This is similar to other Office 

applications with 

your User name, 

Show Mini Toolbar 

on selection, and 

Color scheme. You 

should set your 

preferences here for 

Outlook.  I also 

make sure I make 

Outlook my default 

program for my E-

mail, Contacts, and 

Calendar. 

The Outlook Options 

pane has several 

items that we have studied thus far, such as Customize Ribbon and Quick Access 

Toolbar.  I will overview some of the important items starting with Advanced and Mail 

Options.   
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A d v a n c e d  O p t i o n s  
The Advanced options are not advanced at all and contain some of the most important 

settings that guide your use of Outlook.  You will want to review these options and set 

them as you convert to Microsoft’s Outlook 2010. 

1. With your 

Outlook Options 

open, Click the 

Advanced item. 

2. You should 

review the 

Outlook panes 

and set those 

options.  We will 

review these in 

detail in a later 

section 

particularly the 

To-Do Bar. There 

are other ways of 

quickly accessing 

your Navigation, 

Reading, and To-Do bar options which 

we will learn later.  Pictured here are 

the Reading Pane Options which I make 

sure I change the option of moving 

from one message to another – I 

accidentally change messages from 

Read to Unread by moving my cursor.  I 

like using the first option of marking my 

messages as read after a minimum of 5 seconds – that gives me 

time to preview the message and decide if I need to open it.   

3. Set your options here if you like 
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S e n d  R e c e i v e  
You will want to review and set your Send Receive Options, too.  

Activating the Send Receive Groups dialogue box by Click the 

Send/Receive … button 

on the Send and 

received section of your 

Advanced Options allows 

you to schedule your 

Send Receive and 

perform other important 

settings for you.  
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M a i l  O p t i o n s  
Your Mail Options are packed with all 

sorts of items for review for 

formatting and managing your email 

messages and folders.  Some of the 

items that you want to know are: 

1. Signatures – providing 

information at the 

bottom of all your email 

messages, 

2. Message arrival – 

setting how you want to 

know about incoming 

messages – I have all of 

my options chosen and I 

modified my Desktop 

Alert through the 

Desktop Alert Settings 

so my desktop alert 

remains in view for a 

longer period of time. 

3. Send messages -  This 

section provides ways 

of setting your 

Importance and 

Security Levels on ALL 

of your messages, 

using commas instead 

of semi-colons to 

separate your email 

addresses, and I have 

unchecked the Delete 



IAAP and Greg Creech Office 2010 for Power Users  Page 49 

 

 

www.iaap-hq.org EFAM 2013 gregcreech.com 
Greg Creech © 2013  No Distribution or Duplication  

  Exclusive for IAAP and Techedutainment Services. 

 

meeting requests and notifications from inbox after responding 

because I like to keep this message for future reference and 

assistance.  I certainly like using my keyboard short cut of CTRL 

+ Enter to send a message and I have Outlook suggest names in 

my to, cc and bcc address lines. I haven’t needed nor wanted to 

Delete my Auto Complete List History.   

4. Tracking – This allows you set your Delivery and Read Receipts 

for ALL of your messages; there are  options that allow you to 

only set Delivery and Read receipts for specific messages which 

is what I use.  This section provides ways for you to determine 

how you respond to read receipts, too. 

You should review the other Outlook Objects’ options, too, to set your Calendar, 

Contacts, Tasks, and other items in Outlook. I cover these in detail in other Outlook 

courses. 
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P ro d u c t i ve  R i b b o n ,  b u t   

W h e r e  a re  t h e  B ows ?  
Microsoft’s Office 2007/2010 Ribbon is productive, beautiful, and combines our 

previous toolbars, menus, and task pane features in a much easier and a more powerful 

way of working with the applications.  As a 25-year veteran of using these products, I got 

excited when we moved from command menus to icons, now we can have the best of all 

of the worlds with The Ribbon, especially the ability to customize the Ribbon in Office 

2010 as we accomplished earlier.  I think you are going to find the Ribbon a bit confusing 

at first.  For me, old habits die hard and I had to accustom my life and work without the 

Menu bar and Standard/Formatting Toolbar.  And the Live Preview Feature introduced 

in Office 2007 that displays your selected text’s new format based on hovering your 

cursor over a style, font, or size “freaked” me out at first.  However, once I worked with 

the new Ribbon and features that pop out of nowhere or are enhanced greatly, such as the 

new Mini Toolbar that appears with your Shortcut Menu when you right-click, I find it 

difficult to use previous versions of Office. The 2007/2010 version of Office is much 

easier to use and to teach than any other version, especially for our youth and those new 

to Microsoft’s Office.  Here’s two neat ways of increasing your productivity using the 

Ribbon. 

Two important and time saving Hot Tips for you in using the Ribbon and Tabs! 

 Hot Tip 1:  Minimize the Ribbon! Four ways to minimize the Ribbon – First, 

the Ribbon takes up a lot of space on your screen. You may minimize the 

Ribbon and use it only when you click on a Tab.  

1. Office 2010 has the new Minimize Ribbon arrow at the top of 

your window next to the Help button.  The Minimize the Ribbon 

button appears at right. With the Ribbon minimized the button 

becomes the Expand the Ribbon button.  

2. To minimize the ribbon double click the active Tab’s 

Name. Double clicking a tab expands/minimizes the 
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ribbon, too. 

3. Right click on any tab or command button on the Ribbon and from the 

short cut menu choose Minimize the Ribbon at the bottom of the menu.  

4. Keyboard shortcut of CTRL + F1 – when you press your CTRL (Control) 

and the F1 keys simultaneously on your keyboard the Office application 

minimizes and expands your Ribbon, too.  

Why minimize The Ribbon?  The Ribbon takes a lot of space. With the Ribbon minimized you 

have more room in which to work on your file.  With the Ribbon minimized, to use a tab, you 

click the tab and the Ribbon’s tab expands for you to use the Command Buttons.  After 

clicking the button you want and you click back into the body of your document, worksheet, or 

presentation the Ribbon minimizes again. This is similar to using the old Menu bar.  The 

difference is the Menu bar was vertical and text oriented and the Ribbon is horizontal and 

more graphically oriented.  

 Hot Tip 2: Second, if you have a scroll wheel/button on your mouse 

and the Ribbon is NOT minimized, you may scroll through the different 

tabs rather than clicking the tab.  Moving your cursor to the Ribbon 

and rolling your scrolling button/wheel up or down changes the tabs 

for you! You must first click on a tab for this to work; otherwise, the 

application will scroll through your file – not the Ribbon.   

 An Important Gotcha! With the Ribbon minimized you cannot scroll 

through the Tabs as described above.  You’ll have to maximize the ribbon in 

order to scroll through your tabs and command items.  

Try these two shortcuts, I think you’ll like using these two features in Office 

2010. 
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We l c o m e  H o m e  –  T h e  H o m e  Ta b  
The Home Tab appears above. The Ribbon is composed of Tabs, Command Buttons 

(aka Icons), and Groups.  As you can see, the Ribbon is packed with Command buttons, 

menu items, and are organized in a logical manner.  However, getting accustomed to 

where your previous icons, menu items, and other shortcuts from previous versions of 

Office is a bit challenging.  Here’s an example of how my old habits in the applications 

are hard to change, and I bet you will experience the same.  The Views in Word and 

PowerPoint have always been at the lower left corner of your screen – now the Views in 

Word and PowerPoint have moved to the left of the screen – a simple rearrangement, but 

I can’t count the number of times I still go to the lower right part of my screen to change 

a view and then realize OOPS! the views have moved on me.   

 

An Important Note  - Your screen resolutions will affect the number of commands 

you may see in a group.  The lower the resolution your computer is set the fewer 

commands you may see – the group will display an arrow for you to expand and view 

the commands.  The higher the resolution the more commands you may view in a 

group without the need to expand the group.  For example, with my screen resolution 

set at 800 x 600 my Editing Group required me to expand the group in order to view 

and use the commands.  With my screen resolution set at 1024 X 768 my editing group 

displays the Find, Replace, and Select Commands. You may change your resolution 

settings using the Display Properties and the Settings Tab in Windows XP. 

  

Command Buttons 

Groups 

Tabs 
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Pa s t e  P r ev i e w  a n d  Pa s t e  

O p t i o n s  
The number 1 reason people use the Undo button is to undo an improper 

paste and then must use Paste Special, with which many users were 

unfamiliar.  Now when you Paste you will have Paste Preview in your 

Shortcut menu.  Depending upon what you are copying/cutting to paste, 

the menu will change.  If you are pasting a picture you will have different 

options, than text. I am using text with the Paste Options pictured at right. 

As you move your cursor over the different buttons for Paste, Office 

provides a Live Preview.  At right I am displaying, copying and pasting 

this paragraph into another document and notice that my shortcut menu 

disappears only leaving the Paste Options for me to view and then to 

click to choose the correct paste selection. 

Here are the options when I’m using the Clipboard to perform my paste 

and the Options in Excel. 
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S c re e n s h ot  E d i t i n g  
Wow! What an Improvement – as a writer and specifically a technical writer I use a lot of 

screenshots in my documents.  The process required several steps in the past or the use of 

a third party vendor to accomplish robust 

and quick screen shot editing and use. 

Office 2010 provides Screen Shot and 

editing built into the applications.  

With files and programs open, you may 

use the Insert tab and screen shot. 

I like using Screen Clipping because 

whichever file you were previously 

working you may click Screen Clipping 

and the previous file opens and dims for 

you to click and drag the area that you wish to insert your Screenshot.  If you simply 

click the item in the Available Window menu, the entire screen is inserted into your file.  

After the insertion then you will need to perform any formatting, such as cropping and 

resizing.  

As an example, I open an Excel workbook with a listing of clients, this file appears first 

in my list of Available Windows.  As displayed above I am choosing Screen Clipping and 

since I was in the Excel 

worksheet last, Office 

opens my Excel 

worksheet and dims for 

me to click and drag to 

select the area I want to 

insert into the document 

as displayed here.  After I 

click and drag the area 

and then release my 

mouse button, this area automatically inserts into my Word document! 
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In Outlook, I want to insert a portion of a map for a client that is “directionally 

challenged” (a man no 

doubt).  After using a map 

program to locate the 

address, I open Outlook 

and a new mail message.  I 

click the Insert Tab and 

Screenshot.  The first item 

in the Available Windows 

is the map.  When I click 

screen clipping Outlook 

minimizes and the 

mapping web application 

activates for me to choose 

the area I want including in the email.  After clicking, dragging, and releasing my mouse 

button, the area inserts into my email message as displayed here.  This saves a lot of time, 

especially for all of the screenshots you see in my manuals and books. 

If you have Windows 7 there is a nice Snipping Tool that you may use as well. The 

Snipping Tool allows you to Snip your Desktop and other items that may not include in 

the Office screenshot. 

 An Important Gotcha! You may not (actually CAN NOT) have your 

files/applications minimized to view in the Screenshot menu.  Your files must 

be open, active, and not minimized.  
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O u t l o o k ’s  Pe o p l e  Pa n e  
Outlook has finally moved into the new century.  The People Pane is a popular pane for 

you to use to view ALL email 

messages, appointments, social 

network information, attachments, 

and so on for the for the person who 

you select.   

 

 

 

 

 

 

 

 

 

 

 

 

 

O u t l o o k  Q u i c k  S t e p s  
This is an 

user-

friendly 

way of 

creating 

shortcuts 

known as 

macros. 

Quick steps allows you to set the actions you take to perform a task, such as moving an 

email message to a specific folder or assigning items to a category.  The task completes 

with one click rather than several selections and clicks.  
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O u t l o o k  S c h e d u l e  V i e w  a n d  

C a l e n d a r  G ro u p i n g  
You can create a grouping of calendars for other people, resources, etc. and click a check 

box to display your individual and group calendars.  Outlook expands the view for 

Meetings into the Schedule 

view, so that now you can 

view multiple calendars in a 

more comprehensive and 

helpful view by dates and 

timeframes (you may 

change the timeframe in 

increments such as hourly, 

30 minutes).   
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Powe r Po i n t  A n i m a t i o n  Ta b  

a n d  A n i m a t i o n  Pa i n t e r  
Similar to the Format Painter in the Office Suite, PowerPoint 2010 has the Animation 

Painter which 

allows you to select 

an Animation and 

apply the 

Animation to other 

items and objects.  

Animation Painter 

provides a preview of the animation before you click to ensure this is the animation you 

want to paste.  

Select the text or object with Animation you want to replicate and Click the Animation 

Painter to paste the animation once or double click the Animation Painter to apply the 

Animation to more than one area or object. 

A r t i s t i c  E f fe c t s  o n  P h ot o s  
Office 2007 did a great job of upgrading our ability to enhance our pictures with multiple 

and neat effects, such as shadows, glows, and unique 

rotations.  Office 2010 adds Artistic Effects to the 

options available to enhance and alter photographs.  I 

have a photo selected at right and with my Artistic 

Effects pane active I can view the various effects on 

through Live Preview to determine which effect I may 

want to use. 
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V i d e o  To o l s  –  Fo r m a t  a n d  

P l ay b a c k  Ta b s  i n  Powe r Po i n t  
PowerPoint 2010’s new Format and Playback Tabs for Video tools allow you to create 

interesting color, shapes, transitions, and many options for using videos in a presentation.  

The Format tab allows 

you to present your 

video in unusual 

shapes, colors, and 

effects as displayed at 

right. I have changed 

my color scheme, 

shape, position, size, 

added a reflection, and 

glow.   
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Wo rd  Te x t  E f fe c t s   
When you select text in Word 2010 you can add some 

interesting effects to your text with the New Text effects 

button and menu conveniently located in your Home Tab and 

Font Group.  I am adding a shadow, reflection, and glow to the 

headings to a document.  These effects add a lot of pizzazz to 

your text, as you can see, not to mention tacky.  
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